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|C-CAP 2020 Update 1.1 Release Notes

IC-CAP is the industry standard platform for DC and High Frequency measurement and modeling of
semiconductor devices. For general information about IC-CAP, refer to the Keysight EEsof product

page.

This document describes new features, functionality, fixed issues and known issues in IC-CAP 2020.
It also includes documentation changes and provides workarounds for defects wherever possible.

For more information on known issues in IC-CAP 2020 Update 1.1, or to report a new issue, refer to
the Keysight EEsof Knowledge Center.

To download IC-CAP 2020 Update 1.1, visit the Keysight EEsof Knowledge Center website.

= To install IC-CAP 2020 Update 1.1 in minimal steps, refer to IC-CAP Quick Install and License Setup.
= To install licenses for IC-CAP 2020 Update 1.1 through IC-CAP 2020 Update 1.1 License Tools, refer to
IC-CAP Licensing.

What's New

Enhancements

= |C-CAP adds support for the Keysight 10 Libraries Suite 2020 and later versions on Linux Red Hat
Enterprise 7.

IC-CAP does not support any earlier versions of Keysight |0 Libraries Suite on Linux. Only the
new Keysight 10 Libraries Suite 2020 version and later are supported.

Issues Fixed

= Fixed negative capacitance result in Spectre 2-port simulation with a particular capacitance network.

= Fixed issue of backslash not working in specifying the path to a calset file in ADS-HBT toolkit and
Angelov-GaN toolkit.

= Fixed crash when reading circuit file with a very long equation into IC-CAP MODEL and/or DUT circuit
page.

. Fix%d memory leak that could occur with PEL programmatic modification of the variable value fields in
the IC-CAP variable table.

= Fixed issue of not all data points fully read into Output in HB 2-tone simulation.

= Fixed issue of sampling measurement not working with VSU and HPSMU on 4155/4156.

= Fixed the issue of Input values that could not be set as String-type from PEL.

= Fixed issue when simulating with the ADS simulator (hpeesofsim) and a parameter input controls
parameter TEMP and has sweep type of LSYNC or is the master sweep of another LSYNC input in the

setup.

This fix is only for DC simulations and CV simulations, which do not sweep CV_FREQ at sweep
order 2 or higher. All other simulation types will not produce correct results.


http://www.keysight.com/find/eesof-products
https://edasupportweb.software.keysight.com
https://www.keysight.com/main/software.jspx?ckey=2213548&lc=eng&cc=US&nid=-32898.0&id=2213548&pageMode=CV
https://edadocs.software.keysight.com/display/iccap2020update1/Installation+and+License+Setup
https://edadocs.software.keysight.com/pages/viewpage.action?pageId=536617437
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Installation

= On Linux platforms: If using National Instrument 10 Libraries, Keysight 10 Libraries, or TAMS 10 Libraries
that support VISA interface and instrument connections, these are the default locations that IC-CAP
will search on startup for the appropriate libvisa.so shared VISA 10 shared library file with executable

permission
o The Linux IC-CAP startup script will look for a VISA Shared IO library file named libvisa.so on the
Linux system in the following methods in order
= |If the optional environment variable VISA_IO_LIBRARY_PATH is set in the current user's
environment to have the full file path location to the libvisa.so file, IC-CAP will try to use that
libvisa.so specified file path and no other.
= If the VISA_IO_LIBRARY_PATH environment variable is not set, then IC-CAP will search for a
compatible VISA IO Library shared library in the following locations:
> (Red Hat Enterprise 7 Only) IC-CAP will search for Keysight IO Libraries VISA IO shared
library files with executable permissions
= Linux 64-bit OS (Red Hat Enterprise 7) only: /usr/local/lib64/libivivisa.so and /opt/
keysight/iolibs/libktvisa32.so
o If not found, then IC-CAP will search for a NI IO VISA Libraries libvisa.so shared library file
with executable permissions at the following location:
= Linux 64-bit OS: /usr/local/lib64/libvisa.so or /usr/lib/x86_64-linux-gnu/libvisa.so
= Linux 32-bit OS: /usr/local/lib/libvisa.so
o If not found in the previous location, then IC-CAP will search for a TAMS IO Libraries
libvisa.so shared library file with executable permissions at the following location:
= Linux 64-bit OS: /usr/lib64/libvisa.so
= Linux 32-bit OS: /usr/lib/libvisa.so
o If not found in the previous location, then IC-CAP will search for the IVl Foundation
libivivisa.so shared library file with executable permissions at the following location:
= Linux 64-bit OS only: /usr/lib64/libivivisa.so

The IVI foundation's VISA 10 libivivisa.so will only be able to communicate via VISA
10 with instruments if there is a vendor IO Library installed (i,e. Keysight 10
Libraries or another vendor) and registered with the IVI foundation's libivivisa.so as
an available vendor VISA IO library installed on the system.

Licensing

= IC-CAP requires: a) the version 2019.02 of the EEsof EDA licensing software, b) a minimum code-word
version 2019.02 or above, and c) the licensing server software, Imgrd and agileesofd, to be upgraded
to at least the same versions as what are included in EEsof EDA Licensing software 2019.02. ICCAP
will not start if any of these requirements is not met. Refer to the License Codeword Version
Compatibility Table.

= In the EEsof EDA License Tools version 2019.02, licensing vendor daemon (agileesofd) is integrated
with FlexNet FNP 11.13.1.4 version (Windows) and FlexNet FNP 11.13.1.3 version (Linux) of FlexNet
license manager daemon (Imgrd). For the Windows platform, IC-CAP installer will automatically set up
these two new license server daemons by default for the local node-locked license users; for the Linux


https://edadocs.software.keysight.com/display/iccap2020update1/License+Codeword+Version+Compatibility
https://edadocs.software.keysight.com/display/iccap2020update1/License+Codeword+Version+Compatibility
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platform, you need to follow the Linux Licensing Setup instruction to complete the licensing
configuration process. For more details, refer to Licensing (For Administrators).

Documentation

Starting with the 2020 release, the online help gets a new user interface. The new Ul improves
overall online help usability by providing the following key benefits in addition to several other
minor benefits:

= Table of Contents Sidebar: Displays collapsible Table of Contents for the entire documentation. The
left-double-arrow icon collapses the sidebar, and the right-double-arrow icon displays the sidebar
back again.

= PDF Button: Allows you to instantly generate PDFs of the latest documentation anytime, including
current page’s children pages. Currently, the PDF generation option is available only for 2020 release.
For other releases, you can switch to their Printing Manuals page and download the existing PDFs like
earlier.

= Product Release Switcher: Allows you to view the current page in other supported releases listed in
the drop-down menu. Once you select a release from the drop-down menu, the current page is
updated to show the content applicable to the selected release. The Table of Contents is updated as
well. With this, you bookmark URL of only one release and then switch to other releases from this
drop-down menu.

= Latest Documentation: The documentation available in the new Ul is always kept updated for all
supported releases. These updates are available to you as soon as they happen at our end. This
provides you 24x7 access to the most recent and technically accurate documentation.

For more details, see How to Use Online Help.

Known Issues
Problem Solution

It takes longer time for IC-CAP to launch. Here is the list of possible causes and workarounds:

= Network condition to the license server(s) can affect the
launch time.
= |f a LAN-GPIB interface or a TCPIP instrument had been
connected last time and if the connection is offline at
the next start of IC-CAP, it could be no response until it
is timeout (default is 120s).
Workaround: If this is the case, get the connection back
online. Another workaround is before launching IC-CAP,
open <UserHOME>/.icconfig file in a text editor, search
for 'LINK HDWR "Hardware"', and at the dev_file_list
section change the interface/connection name to
"dummy".
Cleaning up the temporary folder, which is normally
'<UserHOME>\AppData\Local\Temp' on Windows, that
IC-CAP uses could be a potential solution for the longer
time to launch.

The BSIMCMG and BSIMBULK Package are not The 64-bit versions of ADS and IC-CAP work fine.
supported for simulation with the ADS simulator
(hpeesofsim) for 32-bit platforms.


https://edadocs.software.keysight.com/display/iccap2020update1/Setting+Up+Licenses+on+Linux
https://edadocs.software.keysight.com/pages/viewpage.action?pageId=539602111
https://edadocs.software.keysight.com/display/iccap2020update1/How+to+Use+Online+Help
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Problem

System variable WAFERPRO_HIDE_S2_STATUS does
not work on Linux.

In the DEFINE_EXTR_BOX Utilities transform, if you
press OK, Done!, the window is reopened, but it
takes the parameter.

Using Two Port simulations with DC outputs in Eldo,
some two port points (often only the first curve) will
show minor variance from the Two Port Simulation
alone. These variances have only been observed
beyond 8 digits of precision. Keysight is working with
Mentor to determine the root cause of this variance.

ASM_HEMT_MODELING or MVSG_MODELING if
opened through right click 'Edit..." will not load
automatically the required *_GaN_UTILITIES model
files. As a result most transform execution will show a
Error:

For ASM_HEMT_MODELING

[...] Function iccap_func could not
locate 'ASM_HEMT_GaN_UTILITIES/
[...]

For MVSG_MODELING

[...] Function iccap_func could not
locate 'MVSG_GaN_UTILITIES/ [...]

Angelov-GaN modeling package: Tune/Optimize does
not work with the ADS built-in model in ADS2019/
ADS2020.

Angelov-GaN modeling package / ADA-HBT
modeling package gives error: ERROR: Could not set
Cal/State File Name [.cst only] to ...

Angelov-GaN modeling package / ADA-HBT
modeling package gives error: ERROR: Keysight
PNA.xx.xx: While recalling calibration file : C:
\134Users\134Public\134Network
Analyzer\134Documents\134atxxx.csa

Solution

NA

Press OK, Done! and close the Window using the Close
window button (in top-right corner).

Unless the precision beyond 8 digits is crucial, this can be
ignored.

Go to the Main IC-CAP window and double click on the
ASM_HEMT_MODELING or MVSG_MODELING file.

Since the angelov_gan.va file is no more included in the new
ADS versions, the compiled va library of the model for the
ADS versions was added in this IC-CAP installation, which
resolved the tuner/optimizer issue as a workaround. Note
that the model name used in the package was changed
from 'angelov_gan_va' to 'angelov_gan' as the default.

The instrument option name of the PNA driver was changed
to "Cal/State File Name [.csal.cst only]". To update the
internally-stored instrument options list, click Reset 10
Table button in the Measure module window.

Use forward slash instead of back slash even on Windows,
for example:

= C:/Users/Public/Network Analyzer/Documents/
atxxx.csa
= C:/Program Files/Agilent/Network Analyzer/
Documents/atxxx.csa
Note: If the file is in the PNA-default folder (see PNA
manual), just file name without path will work.
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Problem

Angelov-GaN modeling package: simulation fails with
ADS 2014 on Windows7 32-bit platform.

B1500A: Invalid Pulse Width setting in the Instrument
Options table results in Error-120: Incorrect
parameter value.

Instrument option settings is not correctly handled in
measurements if WPRO_INIT transform is added and
it does not have the call to load instrument options.

E4991B is not supported.

In B1500, the measurement fails with NI IO Library in
the old instrument mode.

Unable to simulate few setups in BSIMSOI4 Modeling
Package using ADS 2019 Update 1.0 and ADS 2019.

Variable containing double quotes is not parsed
accurately.

IC-CAP cannot retrieve data from HSPICE result if the
number of signals exceed 512.

When changing DIODE parameters in the Qg setup
(time-domain simulation), at some point the
parameter change makes the simulation not running
without error, and it never recovers from the deadlock
until turning on the Simulation Debugger.

Solution

NA

Set valid Pulse Width:
HPSMU/MPSMU/HRSMU: >= 500us
MCSMU: >=50us / 2us resolution

Insert a line to call WPro_LoadInstrOptions(RoutineName,
SetupName) function in the WPRO_INIT transform of the
user-defined Routine/Setups.

NA

Close the Nucleus software and restart the computer.

Use ADS 2017 Update 1.0 for simulation in the BSIMSOIl4
Modeling Package.

This issue exists in files that are saved in older versions of

IC-CAP. If you save the file in earlier versions 2016.04 with a

variable, for example, xyz "test" and reload it in

2016.04/2018/2020 Update 1. This variable will show as xyz

" or something similar. This issue is fixed in the latest IC-
CAP release.

Workaround:

* Load the file into IC-CAP 2020 or later.
= Fix the double quoted string in the variables.
= Save the file with the new IC-CAP 2020 or later.

Workaround:

Reduce the number of output nodes by
adding #echo .option posttop=1 to the HSPICE

simulations. This option defines the hierarchy depth saved in

output file. For posttop=1, HSPICE only saves voltage and
current information of top level nodes and branches.

Workaround:

The cause seems to be too high impedance at the Gate
node of the model for the time-domain simulation. Add a
100 Tohm resistance between G-S of the transistor in the
Test Circuit.

To view known issues from the previous release, refer: Release Notes 2018, Release Notes 2018 Update

0.1, and Release Notes 2018 Update 0.2.


https://edadocs.software.keysight.com/display/iccap2018update02/Release+Notes+2018
https://edadocs.software.keysight.com/display/iccap2018update02/Release+Notes+2018+Update+0.1
https://edadocs.software.keysight.com/display/iccap2018update02/Release+Notes+2018+Update+0.1
https://edadocs.software.keysight.com/display/iccap2018update02/Release+Notes+2018+Update+0.2

PathWave Device Modeling (IC-CAP) 2020 Update 1.1 Release Notes

Documentation

= On Windows, Printing directly from installed help generates non-readable output. Workaround:
Use PDF version of the document for printing purpose.
= In the installed help when you open a page using the "Open a link in new tab" option the help does
not open a page in a different tab by default. You need to set the preferences to open any link in a new
tab. To set the preferences:
a. From the 201x version of the installed help, Click Edit > Preferences. The Preferences Dialog box is
displayed.
b. Select the Options tab.
c. Under Appearance, select the Show tabs for each individual page option.
This is one time setting for a particular release of a product.
= While using the installed help, you may encounter issues like help not showing any content, it throws
an error, it displays unexpected hierarchy in the Content tab, or it does not display any search results.
Workaround: Close the help, delete the contents of the following directory and open the help again.
o On Windows: C:\Users\<Windows_Login_ID>\AppData\Local\Keysight\Help
o On Linux: $HOME/.local/share/Keysight/Help
» The installed help search does not support [] or {} or any other text using these combinations.

Simulation

o Segment Sweep with Noise analysis is not creating the correct netlist for the ADS simulator.

o Simulating to ADS 2014.01 or later requires IC-CAP 2014.04 or newer version. Older versions of IC-
CAP cannot work with ADS 2014.01 and beyond.

o When performing ADS simulations with Verilog-A references using ADS 2014 and IC-CAP 2014.04
on Linux, ensure to set the environment variable, ADS_LICENSE_FILE, to reference your IC-CAP
license file before launching IC-CAP. Without this setting, ADS will be unable to properly compile
*.va files for simulation.

o ADS simulations to IC-CAP 2016.01 are now performed in the $HOME/hpeesof/iccap_ads/data
directory and not in the current working directory. Although it does not affect most simulations, if
you direct ADS to load a file relative to the current working directory with the assumption that
current working directory will be the same as IC-CAP, this will no longer work for simulations to
ADS 2016.01. Please modify such netlists to refer to the full path of the file that ADS must access.
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Installation
Problem

On Windows systems, if you have installed a pre-release
version of IC-CAP and then try to install the current version or
a newer version of the IC-CAP release, you can get the warning
stating 'Previous Version Detected' even though you have
uninstalled the current version properly.

IC-CAP ships with an installation of ImageMagick ‘convert’ for
the Save Image feature in plots. Without a working ‘convert’
call, the Save Image option can only save JPG, BMP, PNG,
PPM, XBM, and XPM formats. The version of convert shipped
with IC-CAP does not work on Red Hat version 5, though most
default installations of Red Hat version 5 will have a working
ImageMagick tool in /usr/bin/convert folder. IC-CAP tests for a
workable ‘convert’ program during launch. Initially at
$MAGICK_HOME/bin/convert, then within IC-CAP installation,
and finally within the path. A warning about the limited save
options are issued at launch if no working version of ‘convert’ is
found.

Solution

To get past the 'Previous Version Detected'
message while installing, you need to delete
the .com.zerog.registry file.
= On 64 bit systems the file is at C:\Program
Files (x86)\Zero G
Registry\ .com.zerog.registry.
= On 32-bit systems, the path to this file is C:
\Program Files\Zero G
Registry\ .com.zerog.registry. (The
directory Zero G Registry is a hidden folder
so you need to turn on Show hidden files....
On Windows 7, you can get to this setting
under Control Panel\Appearance and
Personalization\Show hidden files and
folder.)

To avoid this warning, you can install a current
version of ImageMagick on your system or set the
MAGICK_HOME environment variable to a working
installation.

10
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Problem Solution

IC-CAP 2020 crashes while launching the 32-bit installer on
some 64-bit machine. A possible workaround is to install the following
libraries:

dbus-libs.i686
libstdc++.i686

zlib.i686
libXrender.i686
libICE.i686

libSM.i686

libXext.i686

libX11.i686
xcb-util.i686

libXi.i686
compat-libxcb.i686
libxcb-devel.i686
xcb-util-devel.i686
xcb-util-image.i686
xcb-util-image-devel.i686
xcb-util-renderutil.i686
xcb-util-renderutil-devel.i686
xcb-util-wm.i686
xcb-util-wm-devel.i686
libX11-devel.i686
libICE-devel.i686
fontconfig.i686

On RHEL 7.1 Workstation.x86_64, install the
following libraries:

compat-libcap1-1.10-7.el7.i686
libXrender-0.9.8-2.1.¢l7.i686
dbus-libs-1.6.12-11.el7.i686
libstdc++-4.8.3-9.el7.i1686
fontconfig-2.10.95-7.el7.i686
libxcb-devel-1.9-5.el7.i686
libICE-1.0.8-7.el7.i686
readline-6.2-9.el7.i686
libICE-devel-1.0.8-7.el7.i686
sqlite-3.7.17-4.€l7.i686
libSM-1.2.1-7.el7.i686
xcb-util-0.3.9-4.el7.i686
libX11-1.6.0-2.1.el7.i686
xcb-util-image-0.3.9-4.el7.i686
libX11-devel-1.6.0-2.1.el7.i686
xcb-util-wm-0.3.9-5.el7.i1686
libXext-1.3.2-2.1.el7.i686
zlib-1.2.7-13.e17.i686
libXi-1.7.2-2.1.el7.i686

If McAfee antivirus is running, it may pause the installation. On disabling the Security firewall option in McAfee
antivirus settings, the installation works fine. After
the installation is complete, enable the Security
firewall option in the McAfee antivirus settings.

11
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Problem Solution

On Linux, IC-CAP is only able to communicate with either Choose to only install either Keysight 10 Libraries
Keysight 10 Libraries Suite 2020 or later versions, or the TAMS Suite 2020 or TAMS IO Libraries on the Linux Red
IO Libraries installed on the same system, but cannot work with ~ Hat Enterprise 7 platform.

both TAMS and Keysight IO libraries installed at the same time.

The libsicl.so installed by both Keysight 10 Libraries Suite and

TAMS 10 Libraries will overwrite each other in the /usr/lib64/

libsicl.so location.

= Unable to install Licensing Hardware Key Drivers on Windows.
Workaround: Turn off UEFI Secure Boot (BIOS) and use the default 6.3 version of the Wibu key driver
delivered with the EEsof Licensing tools.

= Licensing may not support a license file path that is too long. This will likely occur when you have too
many license files.

Workaround: Remove some license files, move the license files to a shorter directory path or to

combine license files into a single file.

= License Setup wizard may not be able to start license server with many license files. During setup, it
may lead to a situation where a command prompt window appears/disappears incessantly. This is due
to the fact that License Setup wizard is not able to start Imgrd with a long command line and may get
stuck in a loop.

Workaround:

a. Itis recommended to combine all license code words tied to same MAC ID into single license file to
avoid setting large number of license files.

b. Try to use a shorter path to place license files.

c. If #1 and/or #2 does not help, start the license server (Imgrd.exe) from the command line (e.g.
Imgrd.exe -c <lic-file-path> -l <license_server_log.txt>) and then set
<PRODUCT>_LICENSE_FILE=<PORT-NUMBER>@localhost for product you want to use on same PC.

= Dongle drivers for Flex-10 dongles on Linux are release specific. Installing the latest dongle drivers on

Linux will function properly only for the most recent EEsof releases.

Workaround: Install and use dongle drivers as needed. If you need to run the most recent EEsof

releases, use the latest Flex-10 dongle driver. If you need to use older releases, uninstall the latest

dongle driver and re-install the older dongle driver

= FLO and EEsof License setup are writing server logs at different locations. However, the EEsof server
log file location is updated in the License Manager > Environment tab.

= When multiple same-named INCREMENT lines of different version exist on the license server, few
advanced FlexNet options to reserve/limit licenses may not work properly.

= Product Selector “Check Availability“ generates incorrect results (which leads to license failure) for
older releases when multiple date base versions of like-named bundles exist in the license pool.

= In Linux, Product Selector OK and Cancel Buttons locations are reserved.

= Starting from FlexNet Publisher 2015 (also known as version 11.13.1), the adoption of the best practice
of the least-privilege security therein results in the License Server related Windows Service to run with
the LocalService Account privilege (instead of the LocalSystem privilege as before.) Running with the

LocalService Account privilege, an executable can no longer access any files located in the per-user

specific type of folders. As a result, any license file placed in those folders can no longer be accessed

by the License Server when the License Server is automatically started via the Windows Service upon
each PC reboot. For the local node-locked license, this would not result in any disruption to the usage
of EEsof applications; however, for the license installed on a network PC that is accessed by multiple
client PCs, this may cause EEsof applications not to start after the network PC reboots

Workaround: Store your license files in the Windows folders that are accessible by the LocalService

12
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Account privilege. For example, C:\ProgramData or C:\users\public are both qualified choices. In
general, any folder that has the "Users" group listed in its Properties > Security page and this "Users"
group has the read permission enabled should work.

Using the default port to connect to a license server may cause a delay when checking out licenses. If
no port is given in the license file, Flexera scans ports 27000 to 27009 to find the port. Starting from
FlexNet Publisher 2015 (aka version 11.13.1), the default timeout for the response from each port
increased from .1 seconds to 3 seconds.

To avoid the delay, KSM now issues licenses with port 27009 instead of leaving this blank. The EEsof
License Setup Wizard (from Licensing 2017.01 onwards) handles some common situations such as:
where it detects license file(s) without port, when users get a new license file with port 27009, or when
all license files for a vendor daemon does not have same port.

You will not be able to start the license server if all license files for a vendor daemon on a server
does not have same port.

Users who manually setup a license server or using EEsof License Setup Wizard with older licensing
bits may need to manually edit license files to comply with the following rules:

a. All license files for a vendor daemon on a server must use the same port (or all be blank).

b. Using the default port (blank) is allowed but may result in longer checkout times.

c. If setting up a network server, select an unused port that is not blocked by a firewall.
Workaround: If the user cannot change the port, or wants to use the default Flexera ports, the
environment variable FLEXLM_TIMEOUT can be set to .2 seconds (200000), to minimize the
performance degradation. However, if the network latency is an issue in your environment, you may
need to fine-tune this setting to minimize the general performance degradation while still
accommodating the network latency.

= Installation of EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) may

hang at 4% (percentage vary based on the products) for few hours or even more on some specific
machines.
Workarounds:
o Disable Firewall setting in Anti-Virus Software installed on the PC.
or
> Download and unzip process explorer from the below link and then invoke procexp.exe.
https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
Right click on the wusa.exe process under <Product installer exe> and select KillProcess. Now it will
continue the product installation.

= After installing EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX)

successfully and try to invoke the software or License wizard, you may encounter “api-ms-win-crt-
runtime-11-1-0.dll” missing error.

Workaround: Install the Update for Universal C Runtime in Windows . On Windows 64-bit system
systems, the file to install is x64 version of the Microsoft hotfix KB2999226. A copy of the Windows6.1-
KB2999226-x64.msu Microsoft 64-bit hotfix installer can be found under the C:\Program
Files\Keysight\EEsof_License_Tools\bin directory. The Microsoft hotfix KB2999226 can be
found under the Update for Universal C Runtime in Windows page at https://support.microsoft.com/
en-us/help/2999226/update-for-universal-c-runtime-in-windows as well.

= On a newly formatted RHEL system, the EEsof Licensing tools may fail to boot. This is because the

FlexNet Publisher 2015 requires a certain rpm

Workaround: Under the EEsof product installation directory, there exists a utility script named
"Linux_sys_check.sh" under the bin directory. Run this script to find out whether any rpm is missing;
run this script with a "-y" command-line option to also have all the missing rpms

automatically installed if you have the sudo or root privilege.


https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
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= License server may stop recognizing Flex-10 dongle on some systems within a few hours after starting
Workaround: If you experience this problem, install the latest WibuKey drivers from Wibu Systems.

= Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a machine
Workaround: Before installing a Flex-10 driver for the first time, unplug the Flex-9 dongle.

= There is a known FlexNet Publisher issue, whereby mixing node-locked codewords and floating
codewords in one license file can result in: a) Remote simulations not working or b) A second local
simulation not working in case the license is node-locked and also has incorrect version.
Workaround: It is strongly recommended that you do not mix node-locked codewords and floating
codewords in one license file nor in any configuration that ends up with node-locked codewords and
floating codewords both available on the same server. In other words, put the node-locked license and
the floating license on different servers, and point to the respective one based on what you need to
run.

= If a user simultaneously runs two instances of a product and has mixed different versions of the same
codeword on one license server, extra licenses may be pulled and result in unexpected “Licensed
number of users already reached for this feature” errors.
Workaround: We recommend you remove expired codewords, to separate out the new and the old
versions of codewords into different files and different servers, and to point to the respective one based
on what you need to run.

= Not specifying the TCP/IP port for the license server during license setup may lead to unexpected
behavior and/or license checkout failure on the Windows platform. We strongly recommend you to
always explicitly specify the TCP/IP port associated with each license server.

= A node-locked and floating bundle operating on Linux cannot be shared between products using EDA
License Tools version older than 2014.01 when run at the same time.

= License Setup Wizard does not remove any previous user-configured FLEX Windows License Service
manually set up by a user using FlexNet's Imtools.
Workaround: You must remove the previous user-configured Windows License Service via Imtools.

o Run the Imtools.exe from C:\Program Files\Agilent\EEsof_License_Tools\bin toinvoke the

Imtools utility. The Imtools utility window is displayed.

If you have installed an EEsof product released before 15t August, 2014 on your system prior
to installing an EEsof product released after 15t August, 2014 then the default EEsof
Licensing tools path will remain C:\Program Files\Agilent\EEsof_License_Tools. On

the systems that only have EEsof products released after 15t August, 2014 installed then the
default EEsof Licensing tools path will be C:\Program
Files\Keysight\EEsof_License_Tools.

o In the Service/License File tab, check the Configuration using Services option. All user-configured
FLEX Windows License Services will be listed.
> Select the service you wish to remove.
o Select the Config Services tab and click the Remove Service button to remove the service.
To ensure that the license service or Imgrd is running, click View Log. A log window appears that
confirms whether agileesofd and Imgrd are up and running.
= While running multiple versions of prior ICCAP releases together, set
ICCAP_MAXIMUM_BUNDLE_USAGE=0N in your environment so that all of them will use the same
method to check out licenses. Otherwise, you might receive an error message, "Licensed number of
users already reached".
* On some Windows 7 machines, when more than one definition of an Ethernet adapter exists
(duplicates), license checkouts may appear to hang up.
Workaround: Disable the duplicate network card definitions in your network settings: Control Panel >
Network and Internet > Network Connections. This issue has been acknowledged by Flexera and they
have created a bug report (SI0C-000103097).
= For LSF style distributed simulations, ensure that the PATH on the client computer points to the
$HPEESOF_DIR/EEsof_License_Tools/${architecture} directory that corresponds to the EEsof release
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https://www.wibu.com/us/downloads-user-software.html
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being used. This needs to be done in order to ensure that the proper version of the Flexera utilities (like
Imutil ) gets picked up in the path before any older in-compatible versions (that may also be installed
on a users’ system.)

License Setup Wizard ( aglmwizard.exe ), which is used to set up and record the license path would
not work if you already have an environment variable set for ICCAP_LICENSE_FILE.

Workaround: You can use ICCAP_LICENSE_FILE variable to point to license file or refer to Licensing
(For Administrators).

The License Setup Wizard will exit or not properly configure a license server, if the server has all of its
licenses currently in use.

Workaround: Wait for a license on the server to become available as you normally would before
launching the product.

Unable to set license in case unicode characters are used either in path or license file name because
the Flex License Service does not support these characters.

The Product Selector tool will be unable to display the license server status properly when connected
to older license server.

Workaround: Upgrade your license server to the latest version.

EEsof Licensing Tools installer can hang on systems with McAfee LiveSafe installed and running the
default firewall settings.

Workaround: Prior to installing EEsof Licensing Tools, temporarily turn off the McAfee LiveSafe
firewall.

Licensing setup steps on systems with McAfee LiveSafe installed can fail.

Workaround: Under the McAfee LiveSafe firewall settings, under Port and Settings, allow the use of
port 27001 for Imgrd.exe under the EEsof Licensing Tools installation bin directory. Under Internet
Connections for Programs , enable Imgrd.exe, aglmmgr.exe and aglmwizard.exe for all devices and
turn off monitoring.

On Windows, EEsof product releases prior to 2014 can have boot time issues with licensing if an newer
EEsof product is installed prior to installing the older product. For example, if a users installs Advanced
Design System 2017 and then installs Advanced Design systems 2014.01, the user can have boot time
errors with ADS 2014.01.

Workaround: For Advanced Design System users, set a system environmental variable named
ADS_LICENSE_FILE under the Control Panel/ System, and Security / System / Advanced system
settings and under the "environmental variables". Add an System variable named ADS_LICENESE_FILE
and the value will be the path to your local license file or the port@host setting for your site.


https://edadocs.software.keysight.com/pages/viewpage.action?pageId=539602111
https://edadocs.software.keysight.com/pages/viewpage.action?pageId=539602111
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